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File Explorer is one of the most used apps in Windows 10 and Windows 11. Whether you need to open, copy, delete, or move files, there is always one thing you have to do first: open the File Explorer. So, I thought it would be an excellent idea to write this roundup article, showing all the ways to open File Explorer in Windows 10 and Windows 11.
They involve everything from using search to pressing keyboard shortcuts, running commands, using speech with artificial intelligence, etc. Lets get started: NOTE: This guide covers Windows 10 or Windows 11. If you dont know your Windows version, read this tutorial: How to tell what Windows I have (11 ways). The keyboard offers fast shortcuts
for launching all kinds of things, including File Explorer. The keyboard shortcut to open File Explorer in either Windows 10 or Windows 11 is:Windows + E The keyboard shortcut to open File Explorer is Win + EAs soon as you press these keys, the File Explorer starts. Windows operating systems include a File Explorer shortcut on the taskbar by
default. To open it, you just have to click the File Explorer icon, which looks like a folder.In Windows 10, the taskbar is left-aligned, and the File Explorer shortcut is located next to Microsoft Edge. Use the File Explorer shortcut on Windows 10's taskbarIn Windows 11, the default location of the File Explorer icon is in the middle of the taskbar. Use the
File Explorer shortcut on Windows 11's taskbarClick the File Explorer icon, and Windows will open its file manager immediately. You can also open File Explorer from any command-line environment you prefer. Start by opening Command Prompt or PowerShell. Then, regardless of whether youre using Windows 10 or Windows 11, run the following
command to open File Explorer:explorer How to open File Explorer from CMDTIP: If you prefer, you can also use Command Prompt or PowerShell inside the Windows Terminal. If youre using Windows 10, click or tap the taskbar search box next to the Start button to type the words:file explorerOnce the search results are in, press Enter or select the
File Explorer result to open it. How to open File Explorer in Windows 10 using searchlIf youre using Windows 11, click or tap inside the search field on the taskbar and type:file explorerAfter the search results are loaded, press Enter or click the File Explorer result. How to open File Explorer in Windows 11 using searchThe File Explorer will open
immediately. If you have a Windows 10 computer, you can launch the File Explorer using its Start Menu shortcut. Open the Start Menu and scroll the list of apps until you reach the folder called Windows System. Inside it, youll find a File Explorer shortcut. Click or tap it, and the file manager will start. How to open File Explorer from the Windows 10
Start Menuln Windows 11, its even easier as this operating system comes with a File Explorer shortcut pinned to the Start Menu by default. Simply open the Start Menu and click or tap the File Explorer shortcut in the Pinned list. How to open File Explorer in Windows 11 from the Start Menu Pinned listAlternatively, you can also open the File
Explorer in Windows 11 from the Start Menu All apps list. To access it, open Start Menu, click or tap All apps and scroll down to the apps that start with the letter F. How to open File Explorer using its Start Menu shortcut in Windows 11TIP: If youre new to Windows 11, heres more information on how to use the Windows 11 Start Menu. Regardless
of whether youre using Windows 10 or Windows 11, press Win + X on your keyboard or right-click the Start button to open the WinX menu. This menu includes a File Explorer shortcut. This is what it looks like in Windows 10: Open File Explorer using its WinX shortcut in Windows 10And heres what youll get in Windows 11: Open File Explorer using
its WinX shortcut in Windows 11Click the File Explorer option in the WinX menu, and the file manager opens immediately. Another method for opening File Explorer is to use the good old Run window. In either Windows 10 or Windows 11, launch Run using the Win + R keyboard shortcut and input this simple command:explorer Then, press Enter on
your keyboard or click/tap the OK button. Open File Explorer from the Run windowThe File Explorer app will open on your Windows computer as soon as you do that. If you have the Copilot on your Windows 10 or Windows 11 device, you can also ask it to open File Explorer. Open the Copilot and, in its text field or using voice, ask it toOpen File
ExplorerConfirm that you want to open File Explorer by clicking or tapping the Yes button in the Al prompt, and the Copilot will launch the file manager. How to open File Explorer using the CopilotTIP: If youd like to know more about Microsofts AI companion, heres How to use the Copilot in Windows 11. Another way to open File Explorer in
Windows 10 or Windows 11 is to add its button in the Start Menu. This is how you do that: If youre using Windows 10, open the Settings app (Win + I) and navigate to Personalization > Start. Then, click or tap the Choose which folders appear on Start link on the right. Go to Settings > Personalization > Start and click Choose which folders appear on
StartThis opens a new settings page with a list of options. On it, turn the File Explorer switch on. Enable the File Explorer switchYoull then get a File Explorer icon on the left side of the Start Menu, above the Power and Settings buttons. Click or tap on it to open File Explorer in Windows 10. How to open File Explorer in Windows 10 using its Start
Menu buttonTIP: For detailed instructions on customizing all the other Start Menu buttons, check out How to add or remove Windows 10 Start Menu folders. On a Windows 11 computer, launch the Settings app (Win + I) and navigate to Personalization > Start > Folders. Then, enable the File Explorer switch on the right. How to add a File Explorer
button to the Start Menu in Windows 11Windows 11 will then add a dedicated File Explorer icon to the left of the Power button in the Start Menu. From now on, you can use it to launch File Explorer quickly. How to open File Explorer in Windows 11 using its button from the Start MenuTIP: If you want to configure the buttons shown in your Start
Menu further, read this guide: 4 ways to customize and improve the Start Menu in Windows 11. Moreover, you can always make a shortcut to File Explorer. If youre using Windows 10, an easy way to do it is to drag and drop the File Explorer shortcut from the Start Menu onto your desktop or in any other folder you prefer. File Explorer shortcut
pinned to the desktop of Windows 10The same goes for Windows 11 too. File Explorer shortcut pinned to the desktop on Windows 11Alternatively, you can manually create a File Explorer shortcut. In either Windows 10 or Windows 11, right-click where you want the File Explorer shortcut, go to New > Shortcut, and follow the steps of the Create
Shortcut wizard. The only essential thing in this process is to input the commandexplorerwhen the wizard asks you about [...] the location of the item: Type explorer in the shortcut's targetYou can then use the new shortcut to launch the File Explorer whenever you need it quickly. Another way to open File Explorer is to use Task Manager. Launch
Task Manager - whether youre using Windows 10 or 11, a quick way to do it is to use this keyboard shortcut:Ctrl + Shift + EscOnce youve opened it, follow these steps: If you are using Windows 10 and the Task Manager opens up in its compact view mode, click or tap More details, then open the File menu, and click or tap on Run new task. Run new
task in Task ManagerIn the Create new task window, type:explorerand click OK or press Enter on your keyboard. How to open File Explorer using Task ManagerFile Explorer will launch in an instant. If you have Windows 11 on your computer, click or tap Run new task in the top-right area of the Task Manager. Run new task in Windows 11's Task
Managerln the Open field from the Create new task window, input this command:explorerThen, click OK or press Enter on your keyboard. How to run File Explorer from Windows 11's Task ManagerWindows 11 will then immediately start File Explorer. Last but not least, you should know that both Windows 10 and Windows 11 store the executable
file for File Explorer in the standard Windows folder. Although redundant, you can also open File Explorer by navigating to your Windows folder and double-clicking the explorer.exe file. But who knows, maybe you need to add its path to a script youre creating: %WINDIR%\explorer.exe Where is File Explorer? Open it by running explorer.exeTIP: In
the path above, I used an environment variable so that the path works no matter on which partition you install Windows. These are all the methods I know for starting File Explorer in Windows. As you have seen, some are very easy, others a bit more complicated. But maybe you know how to open this file manager in other ways? If you do, dont
hesitate to share them in the comments section below, and I will update this article as soon as possible. Thank you!On Windows 10, File Explorer is an essential tool built into the system that allows you to access, delete, create, move, and copy files, whether they are locally stored on the device, in the network, or inside a cloud service like
OneDrive.Although the process to open the file manager is straightforward, it is not obvious for everyone since there are many ways to complete the task depending on where you are in the system.In this Windows 10 guide, we will show you virtually every way you can use to open File Explorer on Windows 10.You may like How to open File Explorer
from taskbarWindows 10 includes many different ways to open File Explorer, but these are the quickest methods.To open the Windows 10 file manager from the taskbar, use these steps:Click the File Explorer (yellow folder in the blue tray) icon in the taskbar.Source: Windows Central (Image credit: Source: Windows Central)Alternatively, you can
also use the Windows key + E keyboard shortcut to open the app quickly.To launch File Explorer from the Quick Link menu, use these steps:All the latest news, reviews, and guides for Windows and Xbox diehards.Right-click the Start button to open the Quick Link menu.Click on File Explorer.Source: Windows Central (Image credit: Source: Windows
Central)The steps below will show you several other ways to access the default file manager app on Windows 10.To start File Explorer from the Start menu, use these steps:Open Start.Select the Windows System folder.Click the File Explorer option.Source: Windows Central (Image credit: Source: Windows Central)Once you complete the steps, the
app will open on the desktop.To open the file manager from the Start left rail, use these steps:Open Start.Click the File Explorer icon from the left pane.Source: Windows Central (Image credit: Source: Windows Central)If the option is not available, you may need to enable it using the Settings app.Show File Explorer icon in Start shortcutsTo show the
File Explorer icon in the Start menu, use these steps:Open Settings.Click on Personalization.Click on Start.Click the Choose which folders appear on Start option.Source: Windows Central (Image credit: Source: Windows Central)Turn on the Windows Explorer toggle switch.Source: Windows Central (Image credit: Source: Windows Central)After you
complete the steps, the option will appear in the left pane on the Start menu.Windows SearchTo run File Explorer from the Windows Search box, use these steps:Click the Search box.Search for File Explorer and click on the top result.Source: Windows Central (Image credit: Source: Windows Central)Alternatively, you can pin the app into the tile
section by right-clicking the File Explorer icon in the Start menu and selecting the Pin to Start option.How to open File Explorer from Run dialogTo launch the Windows 10 Explorer from the Run dialog box, use these steps:Open Start.Search for Run and click the top result to open the Run dialog.Type the following command and click the OK
button.explorerSource: Windows Central (Image credit: Source: Windows Central)Once you complete the steps, File Explorer will open on Windows 10.How to open File Explorer from app locationAlthough it might seem redundant, you can also open the file manager app from its path location.To open File Explorer from its location, use these
steps:Open Start.Quick tip: You can also use the Windows key + R keyboard shortcut to open the Run command.Search for Run and click the top result to open the interface.Type the following path and click the OK button:C:\WindowsSource: Windows Central (Image credit: Source: Windows Central)Double-click the explorer.exe file to launch the
app.Source: Windows Central (Image credit: Source: Windows Central)After you complete the steps, a second instance of the app will open on the desktop.How to open File Explorer from Task ManagerTo open the Explorer with Task Manager, use these steps:Open Start.Search for Task Manager and click the top result to open the app.Quick tip: You
can also right-click the taskbar and select the Task Manager option to access the app. Or you can use the Ctrl + Shift + Esc keyboard shortcut.Click the File menu.Select the Run new task option.Source: Windows Central (Image credit: Source: Windows Central)Type the following command and click the OK button:explorerSource: Windows Central
(Image credit: Source: Windows Central)Once you complete the steps, the app will launch on Windows 10.How to open File Explorer from Command PromptTo use Command Prompt to run File Explorer, use these steps:Open Start.Search for Command Prompt and click the top result to open the console.Type the following command and press
Enter:explorerSource: Windows Central (Image credit: Source: Windows Central)After you complete the steps, the command will launch the application on the device.How to open File Explorer from PowerShellTo use PowerShell to launch the Windows 10 file manager, use these steps:Open Start.Search for PowerShell and click the top result to open
the console.Type the following command and press Enter:explorerSource: Windows Central (Image credit: Source: Windows Central)Once you complete the steps, PowerShell will run File Explorer.How to open File Explorer from desktop iconTo access File Explorer with the "This PC" icon from the desktop, use these steps:Open Settings.Click on
Personalization.Click on Themes.Under the "Related Settings" section, click the Desktop icon settings.Source: Windows Central (Image credit: Source: Windows Central)Under the "Desktop icons" section, check the Computer option.Source: Windows Central (Image credit: Source: Windows Central)Click the Apply button.Click the OK button.After you
complete the steps, the "This PC" icon will appear on the desktop, and when you double-click it, the icon will open File Explorer in the "This PC" section.How to open File Explorer from shortcutTo create a shortcut to open File Explorer, use these steps:Right-click on the desktop.Select the New submenu and choose the Shortcut option.Source:
Windows Central (Image credit: Source: Windows Central)Type the following path to File Explorer and click the Next button:C:\Windows\explorer.exeSource: Windows Central (Image credit: Source: Windows Central)Confirm a name for the shortcut for example, File Explorer.Source: Windows Central (Image credit: Source: Windows Central)Once
you complete the steps, the shortcut will appear on the desktop with the appropriate icon, which you can double-click to open the file manager application.More Windows 10 resourcesFor more helpful articles, coverage, and answers to common questions about Windows 10, visit the following resources: File Explorer is an essential part of Windows 11
that helps you manage your files and folders. But, if it's not pinned to your taskbar, it isn't always obvious how to launch it. Here are five easy ways to launch File Explorer in Windows 11. The Fastest Way: Press Windows+e ojovago\/Shutterstock"> ojovago/Shutterstock At any time while using your PC, press the Windows key and the "E" key
together, and a File Explorer window will pop up immediately. It can't get easier than that! This shortcut also works in Windows 10 and extends all the way back to Windows 95. If you right-click the Start button in your taskbar (or press Windows+x on your keyboard), a hidden "power user" menu will appear. Select "File Explorer" from the list, and
File Explorer will open. You can also find File Explorer in the Start menu. To do so, click the Start button on your taskbar, then type "file explorer" on your keyboard. When you see the "File Explorer" result, either click its icon or simply press Enter, and File Explorer will launch. You can also open File Explorer from the command line. After opening a
Command Prompt, type "explorer.exe" or just "explorer" and hit Enter. A File Explorer window will open to your "This PC" location. The same trick works if you type "explorer.exe" into the Windows+r "Run" box. In Windows 11, you can add a special shortcut to File Explorer that lives in your Start menu. To do so, open Windows Settings (press
Windows+i), then navigate to Personalization > Start > Folders. On the Folders screen, flip the switch beside "File Explorer" to "On." The next time you open Start, you'll see a small outlined File Explorer icon beside the power icon at the bottom of the menu. Click it, and File Explorer will open. Happy exploring! Opening File Explorer in Windows 10
is a breeze and something youll likely do multiple times daily. All you need to do is click the File Explorer icon on your taskbar, press the Windows + E keys on your keyboard, or find it in the Start menu. This quick guide will walk you through all three methods in detail. File Explorer is your gateway to navigate through all the files and folders on your
computer. Heres how you can open it easily using various methods. Locate and click on the File Explorer icon on your taskbar. The File Explorer icon looks like a little yellow folder and is usually located at the bottom of your screen. If its not there, you can pin it for easy access later. Press the Windows + E keys on your keyboard simultaneously. This
method is a bit of a lifesaver if you prefer using keyboard shortcuts. The Windows key is probably the one with the Microsoft logo on it, and the E is for Explorer. Simple, right? Click the Start button and find File Explorer in the list or type File Explorer in the search bar. You can also pin File Explorer to the Start Menu for quicker access next time.
Just right-click on it and select Pin to Start. After completing one of these actions, File Explorer will open, showing your Quick Access items by default. Whether you chose to click the icon, press the shortcut, or use the Start menu, youll have access to all your folders and files. Pin to Taskbar: Right-click the File Explorer icon when its open and select
Pin to Taskbar for one-click access. Create a Shortcut: Right-click on your desktop, go to New, and then Shortcut. Enter explorer as the location to make a quick-access shortcut. Customize Quick Access: Pin frequently used folders to Quick Access for faster navigation. Voice Commands: If you use Cortana, you can say, Open File Explorer. Use Run
Command: Press Windows + R and type explorer to open it quickly. File Explorer is a file management application thats a part of Windows 10, allowing you to browse and manage the files and folders on your computer. Yes, you can right-click the File Explorer icon and select Pin to Start to add it to your Start Menu. You can open File Explorer by
typing explorer in a Command Prompt window and pressing Enter. Yes, you can customize the default view by changing it in the View tab and then applying it to all folders via Folder Options. Absolutely, you can open multiple File Explorer windows by repeating any of the methods mentioned above. Click the File Explorer icon. Press Windows + E
keys. Open from the Start menu. Opening File Explorer in Windows 10 is straightforward and versatile, with multiple methods catering to different user preferences. Whether youre a mouse-clicker kind of person or a keyboard shortcut enthusiast, you have options. Remember, mastering these simple steps can make your daily tasks much more
efficient. For more advanced use, take advantage of tips like pinning to the taskbar or using voice commands. The more familiar you become with these methods, the smoother your Windows 10 experience will be. So go ahead, give these tips a try, and youll be navigating your files like a pro in no time!Matthew Burleigh has been writing tech tutorials
since 2008. His writing has appeared on dozens of different websites and been read over 50 million times.After receiving his Bachelors and Masters degrees in Computer Science he spent several years working in IT management for small businesses. However, he now works full time writing content online and creating websites.His main writing
topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well.Read his full bio here. Download Article Explore the files on your Windows PC with this quick guide Download Article The Windows Explorer (or File Explorer) allows you to find and browse all the files on your
computer. Whether you're running Windows 11, 10, 8, 7, or earlier, you can easily open this tool in the Start menu or with a quick keyboard shortcut. Here's how to open Windows Explorer on your Windows desktop computer or laptop. To open the File Explorer in Windows 10 or 11, click the folder icon in the taskbar. You can also use the keyboard
shortcut: Windows key + E. 1Click the folder icon on the taskbar. By default, this will be on your Windows taskbar at the bottom of your screen. This will open the File Explorer immediately.[1]Alternatively, click the Start menu and click the folder icon. 2Use a keyboard shortcut (optional). You can open the File Explorer using your keyboard.
Advertisement 1Click the Start menu . This will be in the bottom-left corner of your screen.On Windows 8, instead hover your mouse in the upper-right corner of the screen, then click the magnifying glass icon.2Click the "Documents" icon. This is the icon between your user icon and Pictures icon. The Documents folder will open in the File Explorer.To
pin the File Explorer to your taskbar, right-click the icon and click Pin to taskbar.3Use a keyboard shortcut (optional). You can open the File Explorer using your keyboard. Advertisement 10pen the Start menu . Click the Windows logo in the bottom-left corner of the screen or press the Windows key.2Type windows explorer into Start. You should see
a folder icon appear at the top of the Start window.3Click Windows Explorer. It's the folder-shaped icon at the top of the Start window. Doing so will open the Windows Explorer app.With Windows Explorer open, you can "pin it" to your taskbar which will allow you to launch Windows Explorer with a single click. Right-click the Windows Explorer icon
at the bottom of the screen, then click Pin to taskbar.4Use a keyboard shortcut (optional). You can open Windows Explorer using your keyboard. Advertisement Add New Question Question How do I back up my files before installing a new OS? Question Where is Windows Explorer in Windows 8.1? Question What is the purpose of Windows Explorer?
The purpose of Windows Explorer is to let you view, open, copy, move, and otherwise manage your files and folders. See more answers Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional
writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been
viewed 894,418 times. Co-authors: 37 Updated: March 11, 2024 Views:894,418 Categories: Windows PrintSend fan mail to authors Thanks to all authors for creating a page that has been read 894,418 times. "It will enable me to help a friend with a different operating system to find exactly how to open Windows Explorer, which she'd never heard of
before today."..." more Share your story If youre wondering how to open File Manager in Windows 11, youre in the right place. Whether youve just upgraded to Windows 11 or youre looking for faster ways to access your files, this guide covers every method you need to know. In Windows 11, what many people call File Manager is officially named File
Explorer. Its the same tool you use to browse through your computers folders, copy files, and manage your storage. Microsoft gave it a fresh design in Windows 11, but the core functionality remains familiar. The simplest way to open File Manager in Windows 11 is through the taskbar: Look for the folder icon on your taskbar (usually pinned by
default) Click once to open File Explorer instantly If by default the File Explorer icon is not in your Windows 11 Taskbar then in the search box type file explorer and right-click on its icon to select Pint to Taskbar option. Those who want to use the fastest way to access the File Manager on Windows 11 they can take the help of keyboard shortcut.
Press Windows Key + E File Explorer opens immediately This works from anywhere in Windows 11, even when youre in another application This is the traditional way to access any application on Windows 11, follow the given steps. Click the Start button or press the Windows key Type File Explorer or Folder in the search box Click on File Explorer
when it appears in the results Alternatively, look for it in the Pinned section if youve pinned it there Windows 11s improved search makes this method reliable: Press Windows Key + S to open search Type File Explorer or just Explorer Press Enter or click the result The Run Dialog box can be used to quicky open various settings and applications on
Windows 11 including the File Manager, here how? Press Windows Key + R Type explorer in the Run dialog Press Enter or click OK Useful when your desktop is unresponsive: Press Ctrl + Shift + Esc to open Task Manager Click Run new task option given on the top right side on the Task Manager. Type explorer.exe and press Enter For command-
line enthusiasts: Open Command Prompt or PowerShell Type explorer and press Enter You can also open specific folders by typing explorer C:\Users The Quick Link menu provides easy access: Right-click the Start button Select File Explorer from the menu This menu (also accessible with Windows Key + X) offers many system tools Windows 11 lets
you jump directly to frequently used locations: Windows Key + E, then:Click Desktop in the left sidebar Click Downloads for your download folder Click Documents for your documents Click Pictures for your image files You can open File Explorer directly to any folder: Press Windows Key + R Type the folder path (e.g., C:\Users\YourName\Documents)
Press Enter Make File Explorer more accessible: Search for File Explorer in the Start menu Right-click on it Select Pin to Start For desktop lovers: Right-click on your desktop Select New Shortcut Type explorer.exe as the location Name it File Explorer and click Finish Keep it always visible: Open File Explorer using any method Right-click its icon in
the taskbar Select Pin to taskbar Try these solutions: Restart Windows Explorer:Open Task Manager (Ctrl + Shift + Esc) Find Windows Explorer in the Processes tab Click Restart Run System File Checker:Open Command Prompt as administrator Type sfc /scannow and press Enter Wait for the scan to complete Speed it up with these tips: Clear File
Explorer history (Options General Clear) Disable Quick Access if not needed Check for Windows updates Scan for malware Master these time-savers: Ctrl + N: Open new window Ctrl + W: Close current tab Alt + : Go back Alt + : Go forward Ctrl + Shift + N: Create new folder F2: Rename selected item Ctrl + A: Select all items Yes, File Manager and
File Explorer refer to the same application in Windows 11. Microsoft officially calls it File Explorer, but many users still use the term File Manager from earlier Windows versions. If youre searching for File Manager, try searching for File Explorer instead. Its the official name in Windows 11. You can also use any of the methods mentioned above to
open it. Yes! Right-click the File Explorer icon, then right-click File Explorer again and select Properties. In the Target field, add the path you want after explorer.exe. Open File Explorer, click the three dots menu, select Options, and then click Restore Defaults in each tab (General, View, and Search). Yes, if you have Cortana or Voice Access enabled,
you can say Open File Explorer to launch it hands-free. Learning how to open File Manager in Windows 11 doesnt have to be complicated. Whether you prefer clicking the taskbar icon, using the Windows + E shortcut, or any of the other methods weve covered, you now have multiple ways to access your files quickly. The key is finding the method
that works best for your workflow. Keyboard shortcuts offer speed, while taskbar icons provide convenience. Take a moment to try different approaches and see which feels most natural to you. Remember, File Explorer in Windows 11 isnt just about opening folders its a powerful tool for organizing your digital life. Master these opening methods,
explore the new features, and youll navigate your files like a pro in no time.
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